
 

 

 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DOCUMENT DESCRIPTION: NALYSIS 2.0 USER MANUAL  

 

 

 

DWG #: A-820-J-530-4 

 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 2 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

REVISIONS 
 

TABLE 1 

Revision 
Number 

Date 
Revised 

Description of Revision Revision By 

1 03APR2019 Switched over from 820-0007-J-6 
document which was for NAlysis 1.0. 
Add upgrade via YModem in 
Terminal application section; and 
WinGov section. 

HKC 

2 18JUL2019 Update WinGov section. Add System 
Requirements 1.1 
 

HKC 

3 5FEB2020 Update acronym list; add RDU LED 
indicator legend; add Export Data 
section for NCORDER; Inspect Data 
section has updated screenshots and 
instructions for fuel usage estimate; 
update Speed Indicator screenshots 

HKC/LLH 

4 30MAR2020 Updated new Stats tab interface, 
removed autobaud from section 3.0, 
Updated section 4.4 Setup Tab to 
support the newly designed GUI 

BL 

5 13JAN2021 Update Process(*bli) for info on .csv 
outputs, updates for mile post 
location being on plot control display, 
formatting updates NCorder Interface 

JJ 

    

    

    

    

    

    

    

    

    

 
 
 
 
 
  



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 3 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

Table of Contents 

1.0 Nalysis Software ............................................................................................... 6 

1.1 SYSTEM REQUIREMENTS .................................................................................................. 6 

2.0 Installing Nalysis ............................................................................................. 6 

3.0 Nalysis Startup ................................................................................................. 7 

4.0 NFORCE Interface .......................................................................................... 8 

4.1 MENU ................................................................................................................................. 8 
4.1.1 File ............................................................................................................................................ 8 
4.1.2 Download Log ......................................................................................................................... 11 
4.1.3 Set ............................................................................................................................................ 14 
4.1.4 Capture .................................................................................................................................... 16 
4.1.5 Options .................................................................................................................................... 17 
4.1.6 Window .................................................................................................................................... 19 
4.1.7 Help ......................................................................................................................................... 21 

4.2 TERMINAL TAB ............................................................................................................... 22 
4.3 NFORCE TAB ................................................................................................................ 23 
4.4 SETUP TAB .................................................................................................................... 24 

4.4.1 Get Data .................................................................................................................................. 24 
4.4.2 Flash and EEPROM Log Status .............................................................................................. 25 
4.4.3 Get EEPROM .......................................................................................................................... 26 
4.4.4 Set Data ................................................................................................................................... 26 
4.4.5 Clear Stats ............................................................................................................................... 26 
4.4.5.1 From Setup Tab (If equipped with Flash statistics) ............................................................ 26 
4.4.5.2 From Terminal (If not equipped with Flash statistics) ........................................................ 26 
4.4.6 Export ...................................................................................................................................... 28 
4.4.7 Load File ................................................................................................................................. 28 
4.4.8 Save to File .............................................................................................................................. 29 

4.5 DIAGNOSTIC TAB ............................................................................................................ 30 

4.6 RTD (REAL TIME DIAGNOSTIC) LOG ............................................................................ 30 

5.0 NCORDER Interface ..................................................................................... 35 

5.1 MENU ............................................................................................................................... 35 
5.1.1 File .......................................................................................................................................... 35 
5.1.2 Download Log ......................................................................................................................... 43 
5.1.3 Set ............................................................................................................................................ 45 
5.1.4 Capture .................................................................................................................................... 49 
5.1.5 Options .................................................................................................................................... 50 
5.1.6 Plot Options ............................................................................................................................. 51 
5.1.7 Inspect Data ............................................................................................................................ 54 
5.1.8 View ......................................................................................................................................... 54 
5.1.9 Print ......................................................................................................................................... 55 
5.1.10 Window ................................................................................................................................ 55 
5.1.11 Help ..................................................................................................................................... 57 

5.2 TERMINAL TAB ............................................................................................................... 59 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 4 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

5.3 NCORDER TAB ................................................................................................................ 59 
5.3.1 Start/Stop ................................................................................................................................. 59 
5.3.2 Erase Log ................................................................................................................................ 60 
5.3.3 Get Log Info............................................................................................................................. 61 

5.4 DIAGNOSTIC TAB ............................................................................................................ 62 

5.5 PROCESSING LOG FILE ................................................................................................... 64 
5.5.1 File Processing ........................................................................................................................ 64 
5.5.2 File Plotting ............................................................................................................................. 66 
5.5.3 Searching ................................................................................................................................. 74 
5.5.4 Mile Post Menu Item ............................................................................................................... 78 
5.5.5 Inspect Data Menu Item .......................................................................................................... 81 
5.5.6 Print Options ........................................................................................................................... 91 
5.5.7 Data Export ............................................................................................................................. 91 

6.0 NCOMPASS Interface ................................................................................... 92 

6.1 MENU ............................................................................................................................... 93 
6.1.1 File .......................................................................................................................................... 93 
6.1.2 Help ......................................................................................................................................... 93 

6.2 TERMINAL TAB ............................................................................................................... 93 

6.3 NCOMPASS TAB .............................................................................................................. 94 
6.3.1 Setup ........................................................................................................................................ 94 
6.3.2 Operation................................................................................................................................. 95 
6.3.3 GPS .......................................................................................................................................... 96 
6.3.4 CanNet ..................................................................................................................................... 97 
6.3.5 RSSI Real Time Plot ................................................................................................................ 97 
6.3.6 SNR Plot .................................................................................................................................. 97 
6.3.7 Terminal screen ....................................................................................................................... 98 
6.3.8 Start Button.............................................................................................................................. 98 
6.3.9 Diagnostic Button .................................................................................................................. 100 

6.4 DIAGNOSTIC TAB .......................................................................................................... 100 

6.5 WEB PORTAL ................................................................................................................ 100 

7.0 WinGov Interface ......................................................................................... 100 

7.1 MENU ............................................................................................................................. 101 
7.1.1 File ........................................................................................................................................ 101 
7.1.2 Download Log ....................................................................................................................... 101 
7.1.3 Set .......................................................................................................................................... 102 
7.1.4 Options .................................................................................................................................. 102 
7.1.5 Help ....................................................................................................................................... 102 

7.2 TERMINAL TAB ............................................................................................................. 102 
7.3 WINGOV REAL TIME TAB ............................................................................................ 103 

7.4 WINGOV ENG CONFIG TAB .......................................................................................... 104 
7.5 DIAGNOSTIC TAB .......................................................................................................... 104 

8.0 Terminal Interface ....................................................................................... 105 

8.1 MENU ............................................................................................................................. 105 
8.1.1 File ........................................................................................................................................ 105 
8.1.2 Download Log ....................................................................................................................... 106 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 5 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

8.1.3 Capture .................................................................................................................................. 106 
8.1.4 Set .......................................................................................................................................... 106 
8.1.5 Options .................................................................................................................................. 106 
8.1.6 Window .................................................................................................................................. 106 
8.1.7 Help ....................................................................................................................................... 106 

8.2 TERMINAL TAB ............................................................................................................. 106 
8.2.1 Help Button............................................................................................................................ 107 
8.2.2 Exit ........................................................................................................................................ 107 
8.2.3 Clear Screen .......................................................................................................................... 107 
8.2.4 Close RT ................................................................................................................................ 107 

9.0 Generic Screen Tabs .................................................................................... 109 

9.1 TERMINAL TAB ............................................................................................................. 109 

9.2 DIAGNOSTIC TAB .......................................................................................................... 109 
9.2.1 Erase Fault ............................................................................................................................ 110 
9.2.2 Erase EPL.............................................................................................................................. 110 
9.2.3 Erase Stats ............................................................................................................................. 110 
9.2.4 Flash Info .............................................................................................................................. 111 
9.2.5 Repair Cal ............................................................................................................................. 111 
9.2.6 Previous ................................................................................................................................. 112 
9.2.7 Next ........................................................................................................................................ 112 
9.2.8 Read Flash ............................................................................................................................. 112 
9.2.9 Read RAM.............................................................................................................................. 112 

10.0 Abbreviations used in NFORCE Download Files ................................... 113 

11.0 Speed Indicator Setting: ........................................................................... 124 

12.0 Customer Support ..................................................................................... 126 

 

 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 6 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

1.0 Nalysis Software 

The Nalysis software allows communication via RS-232 serial link to the NForce, NCorder, NLIMIT 

NCOMPASS, WinGov and TERMINAL screen (Windows Hyper Terminal). 

The NFORCE, NCORDER and NLIMIT Systems have an integrated recording function which is continually 

operating while the system is functional. These systems record information and store it in three types of 

logs: 1) Faults, 2) Diagnostic, & 3) Statistics). This information can be downloaded using the Nalysis 

software program.  This system scans all inputs and outputs – digitals and analogs – 10 times each second, 

and updates each log as required. 

The Nalysis software also has the interface function to each of the system including the Terminal Interface 

(similar to the Hyper Terminal screen). 

 

1.1 System Requirements 
 

These are derived from Windows 7 requirements: 
 

➢ Processor -1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64).    
➢ RAM - 4 GB with at least 2 GB of available space. 
➢ Disk - 16 GB available space (32-bit) or 20 GB (64-bit).  NAlysis only takes 

up about 13 MB on the hard drive and will run on 32-bit or 64-bit systems. 
➢ Graphics Card - DirectX 9 graphics device with WDDM 1.0 or higher driver. 

 

 

2.0 Installing Nalysis 

➢ If you install the Nalysis for the first time, download the software from the following link: 

 

https://nre-electronics.com/nredownloads.html 

 

➢ From the web page, click on Download NALYSIS Installation Zip File or Download NAlysis Installation 

Executable 

➢ If you downloaded the zip file, open the zip file, and double click on the Nalysis_Installer_xXX.exe that is 

in the zip file.  You may get a security warning when you start the install.  If you do, click on the Run 

button.  Once the installer has started, follow the instructions. 

➢ If you downloaded the executable, double-click on the file to install.  You may get a security warning when 

you start the install.  If you do, click on the Run button.  Once the installer has started, follow the 

instructions. 

➢ You should see a desktop icon after the installation completes. 

➢  
 

https://nre-electronics.com/nredownloads.html
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3.0 Nalysis Startup 

➢ Open  Nalysis from Laptop/Computer by clicking on the desktop icon and click on the required Application 

button to launch the specific Nalysis program. 

 

 

 
 

➢ Select the available Communication Port and click on Connect to establish communication between System 

and Nalysis 
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4.0 NFORCE Interface 

Open NForce application by clicking on its button: 

 

  
 

When selecting NFORCE, the user will first enter the Terminal tab of the NFORCE application. 

Note: The following functionality is only available on NForce systems that have Nalysis communications 

Drivers. 

 

 
 

4.1 Menu 
There are pull down Menu available for various functions in the NFORCE application. 

 

4.1.1 File 
The File pull down menu is available for the following functions: 
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- Connect/Disconnect 

• Allow User to Connect or Disconnect communication between NFORCE 

system and Nalysis. 

 

- Firmware Update 

• Allow User to update Firmware to the NFORCE system 

 

• To upgrade the NFORCE firmware, you must do the following: 

➢ Isolate the locomotive and shut down the engine(s).  

➢ Connect the communications cable to the front of the CPU board 

and your laptop. 

➢ Exit any real-time viewing screen in the Terminal or NFORCE 

tabs. 

 

• For automatic update, ensure the Auto radio button is selected (software 

default) 

• Select File->Firmware Update>CPU, an open file dialog similar to the one 

below will appear 
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• Browse to the location of the NFORCE firmware on your 

Laptop/Computer.   

i.e.  

The NFORCE firmware number = 820-0###-xXX.ecm (where ### = 

the NFORCE Firmware number, and xXX = Latest Revision) 

 

• Double click on the *.ecm file to upload the Firmware to the system 

 

CAUTION: DO NOT INTERRUPT COMMUNICATIONS DURING THIS PROCESS; it could 

cause a fatal fault inside the NFORCE. 

- Convert 

• To convert the RTD file with the “.bin” extension into a text file that is 

ready to analyze. 

• Convert an NVision 3 file to a CSV formatted file.  The file was 

downloaded via the USB port on the NVision 3.  This can also be used to 

convert a Fault or EPL “.bin” file that was downloaded from the NForce that 

has the binary download feature. 
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• Then select the file type in the Open File Dialog window. 

 

• Convert a Fault or EPL file that was downloaded from the NRE website that 

was transmitted by NCompass. 

- Make NVision Import DB Files 

• For Engineering use only.  This will be greyed out for non-Admin users. 

 

- Admin 

• Only available to the programmer. 

- Exit 

• To exit NAlysis program. 

4.1.2 Download Log 
This feature allows the User to perform the system log download from the pull down 

menu. 

 

- Diagnostic 

• Diagnostic log download can be useful to observe the most recent 

performance of the locomotive.  The log has all of the data download at 0.1 

second intervals for around 1.5 to 2.0 minutes prior to taking the download. 

• Click on Diagnostic to download the Log to file.  Save the file to a 

designated location on Laptop/Computer for viewing. 
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- EPL 

• The EPL stores long term locomotive data and can be used along with the 

Diagnostic and Fault downloads to provide a clear record of the operation 

and performance of the NFORCE system.  When a fault is detected, the 

associated fault and data packets are recorded to both the fault record and 

the extended performance log.  Certain events also cause data packets to be 

recorded to the EPL. A data packet is recorded to the EPL when the 

following events occur: 

➢ A monitored digital input signal changes state (turns ON or OFF) 

➢ A monitored analog signal changes by a pre-set threshold 

➢ A predefined number of minutes (typically 10 minutes to maximize 

recording memory) has passed since the last data packet was 

recorded 

➢ Downloads might only be performed if the locomotive is Isolated 

and is not Loading. 

• Click on EPL to download the Log to file.  Save the file to a designated 

location on Laptop/Computer for viewing. 

➢ Download using Percentage.  This option will prompt you for a 

percentage if you’re using a system that uses ASCII.  If your 

system utilizes binary downloads, this option will automatically 

download 100% of the EPL.  If not, then you’ll get a prompt to 

specify a percentage: 

 
➢ Download using Date Range.  This is more efficient than the 

percentage download, if your system has binary downloads 

available.  If your system does not binary downloads, this option 

will inform you that the feature is not available.   
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- Fault 

• The Fault log can be useful to identify problem with Feedback signals such 

as Contactor Fault or an open Solenoid.   

• Ensure that the locomotive is in Isolated and is not Loading.  Initiate the file 

transfer by clicking on Fault to Download the Log file.  Save the file to a 

designated location on Laptop/Computer for viewing. 

 

- Statistics 

The Statistics Log records various information that relates to the locomotive and 

its operation. Most of this information is cumulative and is referred to as 

statistics; whereas some information defines the parameters of the locomotive 

and the NFORCE System. All Lifetime Statistics are also stored in an external, 

non-volatile memory device which remains on the locomotive at all times. 

Note: For an NFORCE system that has NAlysis communication capability, a 

Statistics Log can be downloaded and saved from the Setup Tab (see Section 4.4)   

 

The Statistics Report contains the following information: 

• Date/Time (settable parameter) is the time and date of the download 

computer when data was downloaded from the NFORCE. 

• Firmware Version indicates the version and revision of the NFORCE 

internal operating software. 

• Loco ID (settable parameter) is the ID number of the locomotive from 

which data was removed. The ID number is composed of 5 alpha-numeric 

characters.  Acceptable characters include numbers 0-9, letters a-z and 

letters A-Z.  Space is used for blanks in the event the ID number is less than 

5 characters in length. 

• Wheel Diameter (settable parameter) is the diameter of the locomotive 

wheel in inches. 

• Axle Gen PPR (settable parameter) is the pulses per revolution (PPR) of the 

incoming speed signal from the installed speed pick-up equipment. 

• Idle Parked indicates the number of hours that the locomotive has spent 

with the engine at idle and the reverser in neutral. 

• Idle Working indicates the number of hours the locomotive has spent with 

the engine at idle and the reverser set in either forward or reverse. 

• Idle Limit Shutdown indicates the total hours the engine spent in NFORCE 

Shutdown mode.  

• Isolated indicates the total hours the locomotive spent with the isolate/run 

switch in the isolate position. 

• Running indicates the total engine run hours. 
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• Shutdown indicates the total engine shutdown hours (manual and 

automatic.) 

• Stop, Notch 1-8 displays the time in hours spent at various throttle 

positions. 

• Engine Run Times displays hours and minutes spent at each RPM setting. 

• Distance displays miles traveled in forward, reverse and neutral. 

• Energy displays total energy consumed in kWh. 

• RESTART COUNTS (ENGINE RESTART COUNTS) displays the Reason 

for each engine NFORCE, each recorded for the Lifetime of the Trip. 

• SHUTDOWN TIMES (UNABLE TO SHUTDOWN TIMES) displays the 

Reason for each engine shutdown failure and the associated number of hours 

accumulated. 

 

- Report 

• Currently not available. 

 

- Flash Backup 

• This option downloads the statistics log from a backup memory location in 

the NForce.  The data is the same as the Statistics log. 

 

4.1.3 Set 
This feature allows the User to set the System Real Time Clock, NForce Wheel Diameter, 

NForce Loco ID, NForce PPR, and Extended Performance Log. Download settings are 

available in the Set pull down menu. 

 

- System Real Time Clock 

• To set the Real-Time Clock, click on System Real Time Clock 

 

 
 

Note:  

➢ For systems with the Nalysis communications driver, choose Binary then click 

OK to set the system time and date (i.e. NCorder, NForce, and NCOMPASS) 

➢ For systems without the Nalysis communications driver, choose ASCII then 

click OK to set the system time and date (i.e. NForce, and NLIMIT with Hyper 

Terminal communications) 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 15 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

 

- NForce Wheel Diameter 

• To set Wheel Diameter, click on NForce Wheel Diameter 

 

 
 

- NForce Loco ID 

• To set Loco ID, click on NForce Loco ID 

 

 
 

- NForce PPR 

• To set PPR, click on set NForce PPR 
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- Baud Rate 

• To change the communication speed with the NForce, RDU, or NCorder 

unit.  (Note: This may not be available for your NForce system).  If 

successful, the bottom left corner will show the changed baud rate.  This 

setting is temporary, depending on whether a Fault, EPL, or NCorder 

download occurs which will reset the baud rate to 115,200 after completion. 

 

 
 

 

4.1.4 Capture 
This feature will allow the User to capture the Real Time Updates of the NFORCE 

operation.  Click on Capture and select Start to begin the process, select and save the file 

to the designated location then perform the operation that you need to capture.  To stop 

the capture process, click on Capture pull down menu and select Stop. 
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4.1.5 Options 
• Click on the Options pull down menu and the following screen will appear: 
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• If Auto Close RT Window is selected, real time screens will automatically 

close when exited, otherwise they remain open until the Close RT button is 

pressed.  

• If Echo Characters is selected then key presses are echoed to the Terminal 

screen.  

• Reset CPU will send the soft reset command to the NFORCE.  If all reset 

conditions are met the NFORCE will reset without shutting down power. 

•  Get FW Version will retrieve the system’s current firmware version 

(Nalysis communications driver required)  

• Language allows the user to select display in English, Spanish or French. 

(Current set for English only) 

• FW Update auto/man allows the user to select automatic or manual firmware 

update.  This option functions the same as the FW Update radio buttons that 

appear on the top right of the Nalysis screen.  
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4.1.6 Window 
• This feature allows you to select the screen options to either Terminal or 

Process file 

 
 

 

• When selecting Terminal from the Window pull down menu, the active 

screen will show the Terminal, NForce, Setup, or Diagnostic tabs if using 

NForce.  If using the NCorder application, the Terminal option shows the  
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• When selecting Process file, the active screen will show the data screen that 

will allow user to either process the (*.bli) file or open the (*.pro) file from 

the File pull down menu for data viewing.  See Processing Log File section 

for more details. (This feature is only applied to the NCorder application) 
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4.1.7 Help 
Warning: Installing the latest NAlysis may not be compatible with your 

existing NForce, NCorder, or NCompass systems.  Ensure that your systems 

are up-to-date before using the latest NAlysis by consulting release notes or 

FMI (field maintenance instruction) documents. 

 

 

• This Help menu option contains information about NAlysis, Check for 

Software Updates, and Manual 

 

 
 

 

• Ensure that you have a network connection to the Internet, then click on 

Check for Updates. The following window will appear. Click on Download 

NAlysis Installation Zip File or Installation Executable link and follow the 

directions to save the file. 
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If you downloaded the Zip file, double-click on the zip file to view the installer 

file inside.  Double-click on the installation executable to install 

 

• To get the latest user manual, select the Manual option. You’ll be greeted 

with the same options as the Check For Updates option. Click on the 

NALYSIS User Manual link to download. 

 

 

4.2 Terminal Tab 
 

This Terminal screen is similar to the Hyper Terminal screen.  Type in “h” from the terminal 

prompt to view the list of Terminal Commands.  This list of commands varies from one application 

to another as shown in Section 8.1 Terminal Tab. 
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4.3 NFORCE Tab 
There is an NForce Tab available for systems that contain the Nalysis communications drivers.  

The following window will appear if you click on the NForce tab->Main->Analog.  If the drivers 

are not available in the system, a “Disconnected” message will be displayed at the bottom right 

corner.  This means you’ll need to use the Terminal Interface. 

 
 

➢ This is a real-time screen of the NForce system that displays all of the Analogs reading and the 

active faults screen on the lower left (faults are displayed in Red). 

➢ To go to the different screen, simply click on the radio button on the Screen Select or Display. 
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4.4 SETUP Tab 
The Setup screen gives the User the ability to set and view the Parameters and accumulated 

Statistics saved in the NFORCE CPU, or in the EEPROM backup log.  There are multiple options 

available from the Locomotive Setup box on the top of the Setup screen. 

 

Note: This feature is only available on NFORCE systems that have the Flash updates capability. 

 

 
 

4.4.1 Get Data 
Click on the Get Data button from the Locomotive Setup box to view the current 

parameter settings and accumulated statistics saved in the NForce CPU Board.  

The Parameters setting could also be verified and set manually from the Setup Parameters 

box on the left-hand side of the setup screen.   If you want to change any of the 

parameters or statistics, double click on the field immediately to the right of the parameter 

or statistic.  When you have selected the field, type backspace to delete the current setting, 

then enter the desired parameter or statistic value.  

 

Note: Every time the Get Data button is clicked a copy of the current statistics and 

setup parameters are auto saved to: C:\NAlysisV2\StatsBackup\. The file name 

format is as follows Stats_CUSTOMERID_LOCOID_DATE_TIME.bin.  The 

filename and auto save feature is indicated by the highlighted yellow line under Step 

4.   
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4.4.2 Flash and EEPROM Log Status 

Click on the Get Data button will update the current status of the CPU Flash and 

EEPROM logs.  This data is located above the Setup Parameters column. 

The top field shows the status of the system key: 

i.  System Key OK.  This indicates the EEPROM and CPU logs are synchronized 

and working properly. 

ii. System Key FAIL.  This indicates that the system key in the CPU is different 

from EEPROM key stored.  This can happen if one log becomes corrupt, the 

EEPROM fails or the CPU board is changed. 

iii. EEPROM BUSY.  This indicates the EEPROM is currently being read.  Upon 

successful read the System Key status will be updated. 

The bottom field shows the status of the EEPROM. 

i. READING EEPROM DATA ATTEMPT #, where # is attempt 1, 2 or 3. This 

occurs when the NFORCE is first powered on.  The EEPROM logs are being 

read and validated from the EEPROM. 

ii. WRITING LOG1, READING LOG1, REPAIRING LOG1, WRITING LOG2, 

READING LOG2, REPAIRING LOG2. These indicate that data is currently 

being saved to the EEPROM logs and validated. 

iii. ACCUMULATING EEPROM STATS.  This indicates that the EEPROM log 

has finished its read/write cycle and is idle until the next update period. 

Note: While the EEPROM is busy reading or writing, all buttons in Step 2, Step 3 

and Step 4 (Optional) will be greyed out until the EEPROM has finished reading. 
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4.4.3 Get EEPROM 
If the EEPROM status reads ACCUMULATING EEPROM STATS then the A: Get 

EEPROM button under the step 2 section will no longer be greyed out.  Click this button 

to populate the Setup Parameter and Statistics tables with the values stored in the 

EEPROM log backup copy.  The EEPROM log is a backup log and can be used to restore 

the statistics in the event of a CPU board failure or corruption. 

 

 

4.4.4 Set Data 
If the Setup Parameters and Statistics in the table are correct, Click on the Set Data button 

and click YES.  This will save all Parameter settings and Statistics to the CPU Flash 

log and Backup EEPROM log. 

 

   
 

Note: All of the up-to-date Statistics will be erased and replaced with the current 

values from the table.  Proceed with precaution. 

 

4.4.5 Clear Stats  
4.4.5.1 From Setup Tab (If equipped with Flash statistics) 
If you want to clear the statistics, click on the C: Clear Stats button.  You will see all of 

the accumulated statistics values get set to zero.  Then click on the Set Data button to save 

(see section 4.4.4). 

 

Note: Proceed with caution!  NRE recommends you perform a stats log 

download before proceeding with any stats clearing commands. 
 

4.4.5.2 From Terminal (If not equipped with Flash statistics) 
 

- Clear Stats from Terminal Tab Interface 

1. Many NFORCE systems running Terminal Interface have the ability to clear the 

statistics log via the FS0 screen.  Check that your NFORCE system has this capability 

by navigating to the Terminal tab and typing ‘FS0’ without the single quotes.  This 

would take you to a screen that looks like this: 
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Make sure that you’re able to see the E3PROM Activity Status is OK.  If that’s the 

case you’ll also see the “(A) Clear ALL” option.  Type ‘A’ (without the single 

quotes) to erase the stats.   

 

2. The “Clear All” operation takes about 5 minutes as the NFORCE has to communicate 

to the power supply board and then onto the EEPROM that is in the harness.  The 

FS0 screen provides feedback to the user that the interaction with the EEPROM is 

completed. 

3. Once the stats are erased, the user will typically need to enter the following 

parameters again: 

a. Wheel diameter 

b. Locomotive ID number 

c. Load meter calibration (if equipped) via the IO test sequence  
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4.4.6 Export 
This feature lets the User export Stats and Setup information to a .CSV file which can be 

saved for review or to be used again.  Accept the default file or enter the new file name 

then save. 

 
 

4.4.7 Load File 
This feature allows a user to recover the statistics and setup configuration from a saved 

file.  Select the “*.bin” file and click on Open to complete the process.  Then click on Set 

Data to write the parameters and statistics to the CPU and EEPROM. 

 
 

 

 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 29 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

 

4.4.8 Save to File 
This feature allows the user to save the current NFORCE Setup and Statistics file to 

Laptop/Computer for review or future use.  Click on Save to File button and select the 

default or enter the new “*.bin” file name then click on the Save button to complete the 

process. 
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4.5 Diagnostic Tab 
This Diagnostic screen is similar to the FS5’s memory screen from Hyper Terminal.  This screen 

contains features that can be used for analyzing or trouble shooting the memory tables.  See 

Section 8.2 Diagnostic Tab for more details. 

 

4.6 RTD (Real Time Diagnostic) Log 
 

➢ RTD log download can be useful to observe the most recent performance of the 

locomotive.  The log has all of the data download at 0.1 second intervals from the time 

that the download is started until the time that the download is stopped.  This download 

can capture complete tests without the restrictions of the Diagnostic download. 

➢ Click on the Nforce tab, then click on Main in the Screen Select section as shown below. 

 

 
 

 

➢ Click on the Stop button under the Record section on the screen shown below (zoomed from 

above screen view) 

 

 
 

 

➢ Then click on the record button shown as the in the zoomed in picture above. 
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➢ The following screen will appear: 

 

 
 

➢ A default file name is created (LogType_yyddmmhhmmss.bin, in this case it is 

RTD_150707122503.bin), which the user may change to any other name.  Once the user is satisfied 

with the filename and directory, clicking save will start the log download.   

➢ The screen will return to the main data screen, although you may notice that the updates and serial 

monitor numbers are updating more quickly. 
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➢ Perform the locomotive testing that you want to capture.  When you are finished with the testing, 

click on the Stop button under the record section to stop the download.  The recording stopped 

message will be displayed as shown below. 

 

 

 
 

 

➢ The file will be saved as a .bin file instead of a .txt file.  To convert the file to be imported into 

Excel, click on the File pull down menu and select Convert, and then select Diagnostic. 
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➢ Click on the RTD download file that was just saved, and click on Open. 

 

 
 

 

➢ The following message will be displayed when the conversion is finished. 
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➢ To view the RTD’s text file, open the RTD.txt file by using the Download Analyzer program (820-

0442-x##.xls, where ## = latest revision).  The example data file will be displayed like below. 
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5.0 NCORDER Interface 

Access the NCorder application using the application bar: 

 

 
 

 

5.1 Menu 
 

5.1.1 File 
 

 
 

- Connect/Disconnect 

Allow User to Connect or Disconnect communication between NCorder system and 

Nalysis. 

 

- Firmware Update 
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Steps to install an update revision of the event recorder’s operating firmware: 

1. Connect the Serial Communications Cable (NRE Part No. 058-0001-000) to 

the Serial port on the Laptop/Computer. Connect the other end to diagnostic 

port (Lemo connector) on the Remote Download Box (RDU).   

2. Select File->Firmware Update->CPU.  

 

 
 

 

3. From the NRE CPU Binary File window box, locate the up-to-date file on 

the Laptop/Computer hard drive or network.  Select the following file 

options: 

➢ NCorder model number 920-0001-000 use 820-0249-xXX.ecm, where 

XX = Latest Revision 

➢ NCorder model numbers 920-0005-000 and 920-0006-000 use 820-

0303-xXX.ecm, where XX = Latest Revision  
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4. Click on Open. The progress status bar will show the uploading progress of 

the Firmware Update. 

 

CAUTION: DO NOT INTERRUPT COMMUNICATIONS OR TURN OFF THE 

NCORDER OR RDU DURING THE UPDATE PROCESS; it could cause a fatal 

fault inside the event recorder. 

 

 

 

 

 

 
 

- To install an update revision of the remote download units’ (RDU) operating 

firmware: 
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1. Connect the Serial Communications Cable (NRE Part No. 058-0001-000) to 

the proper serial port on the portable computer. Connect the other end to 

diagnostic port on the Remote Download Box.   

2. Select File->Firmware Update->ST 

 

 
 

3. Locate the updated RDU Firmware file (820-0246-xXX.st4, where XX = 

Latest Revision) on the Laptop/Computer or network. 

 
4. Select Open. The progress status of the file upload appears in the Uploading 

New Software dialog box. 

 

CAUTION: DO NOT INTERRUPT COMMUNICATIONS DURING THIS PROCESS; it 

could cause a fatal fault inside the RDU. 
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5. After the RDU is updated, its status will be “Initializing…”  If this status 

does not change to “Normal” after 2 to 3 minutes, power cycle the NCorder 

and RDU.  The status will be “Normal” if the RDU is functioning correctly. 

 
 

 
 

6. If you are downloading the data with a USB thumb drive, this will be 

displayed: 
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7. There are LEDs on the RDU (Remote Data Unit) indicate certain 

overlapping behaviors also: 

 

Action Indicator 
Indicator 
Behavior 

Indicator 
Color 

Data upload to USB 
UPLOAD IN 
PROGRESS 

Flashing Fast Green 

Data upload to USB 
is done 

UPLOAD 
Complete 

Solid Blue 

RDU getting data 
from NCORDER 

UPLOAD IN 
PROGRESS 

Flashes for each packet 
received from NCorder 

Green 

Problem with 
Memory Stick 

Combination 
of UPLOAD 
IN 
PROGRESS 
and UPLOAD 
COMPLETE 

Flashing 
Fast 

Flashing 
Fast 

Green Blue 

Normal Operation STATUS 1 
Flashing once per 
second 

Green 
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Fault Indicator STATUS 2 Solid Red 

RDU Power Up; or 
Memory Stick is 
inserted on startup 

STATUS 2 Flashing Fast  Red 

 

 

- Open (*.pro) 

 

• To open a *.pro file, make sure that you’re in the Process File mode by 

going to the Window pull down menu and clicking on Process file.  If you’re 

already in the Process File mode, you’ll see the Plot and Tabular tabs 

 

 
 

• Go to the File pull down menu and click on Open (*.pro) and select the file 

to be processed from the Log file window 
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- Process (*.bli) 

• This feature allows the User to process the *.bli file from a previous 

download 

• Go to File pull down menu and click on Process (*.bli)>NCorder>##% and 

select the *.bli file to be processed from the Log file window  

 

 

 
- Admin 

• Only available to the Programmer 

- Exit 

• To Exit NAlysis 
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5.1.2 Download Log 
 

• There is a Download Log pull down menu available for downloading logs 

on the NCorder system.  This will provide you with a way to view and 

diagnose problems that occur during its operation.  The NCorder log can be 

downloaded at either 100 Percent, Date Range, or Since Last. 

 
 

• After any of those selections, you’ll be prompted with where to save the file: 

 
 

If you selected By Date Range, you’ll be shown a list of possible dates.  You 

cannot pick the same date for both the From and To; nor can you pick a 

From date that is later than the To date.  The End Date option is so that you 

can get the most recent data.  Note that the date-time options have a 

resolution showing to the hour.  That could mean several minutes into the 

hour and not exactly on the hour as the display might suggest.  
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If you selected 100% Download or Since Last, the following summary 

window appears.  Since Last uses the last 100% Download or Since Last.  It 

does not reference Date Range downloads.  In addition, in some cases where 

the NCorder log has recorded past the Since Last reference point, a message 

appears saying “No since last available”. 
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• The progress bar will show the status of the downloading process.  You 

must be in Terminal mode to see the progress bar. 

 

 
 

• Once the downloading is complete, the following pop-up window will be 

displayed. Click OK to complete. 

 

 
5.1.3 Set 

• This feature allows the User to set the System Real Time Clock, Event 

Recorder Threshold and Parameters, Speed Indicator, Spare Signals, and 

NCorder Kit#.  These settings are available in the Set pull down menu. 

 

 
 

- System Real Time Clock 

 

To set the Real Time Clock, click on System Real Time Clock 
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You should see a confirmation dialog with “RTC time set”.  If not, then try 

again; and/or switch from Binary to ASCII before clicking OK. 

 

 

 
 

Note: For systems with the Nalysis communications driver Select Binary then click OK to 

set the system time and date (i.e. NCorder, NForce, and NCOMPASS) 
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- Event Recorder Threshold and Parameters 

➢ To set thresholds and parameters, click on the Set menu item, the submenu 

item - Event Recorder Thresholds and Parameter.  Enter the required values 

and click on OK to accept the new settings. (see NCORDER manuals for 

more information for settings) 

 

 
 

- Speed Indicator 

➢ Ensure the locomotive is stopped. 

➢ NALYSIS must establish communications with the Speed Indicator before 

any communication operation can be completed. This is done by connecting 

the communications (or download) cable (NRE P/N: 058-0001-000) from 

the Speed Indicator’s communication port (Lemo connector on the back of 

the speed indicator) to a portable computer (or Laptop). 

➢ Launch NCORDER NALYSIS  

➢ Select Set->Speed Indicator 

 

For Imperial Units, the following panel will be displayed: 
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• Locomotive Overspeed can be set between 20 and 100 MPH (32-160 KPH) 

• Wheel Diameter can be set between 32.0” and 47.0” (813 mm and 1192 

mm) 

• For the Recovery selection box: 

o Check box for MVOS braking control 

o Un-check box for excitation reduction control 

 

For Metric Units, the following panel will be displayed: 

 

 
 

• Locomotive Overspeed can be set between 20 and 100 MPH (32-160 KPH) 

• Wheel Diameter can be set between 32.0” and 47.0” (813 mm and 1192 

mm) 

• For the Recovery selection box: 

o Check box for MVOS braking control 

o Un-check box for excitation reduction control 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 49 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

 

• Once your parameters are set, click on Send 

 

- Spare Signals 

• This feature allows the User to manually set up the Spare Signals layout for 

viewing of the Real-Time Signal Update screen 

 

 
 

Note: This feature is only supported on the Stand-Alone Event Recorder  

 

 

- NCorder Kit# 

 

• This feature allows the User to set the NCorder Kit number that is applied to the 

specific application.  Once the NCorder Kit number is set, the Nalysis 

application will display their default setting for Real Time Update signals. 

 

 
 

Note: This feature is only supported on the Stand-Alone Event Recorder  

 

 

5.1.4  Capture 
• This feature is not available on the NCorder application 
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5.1.5 Options 

• Click on the Options pull down menu and the following screen will appear: 

 

 
 

• If Auto Close RT Window is selected, real time screens will automatically close 

when exited, otherwise they remain open until the Close RT button is pressed. 

(This feature is not available on the NCorder application) 

• If Echo Characters is selected then key presses are echoed to the Terminal 

screen. (This feature is not available on the NCorder application) 

• Reset CPU will send the soft reset command to the NFORCE.  If all reset 

conditions are met the NFORCE will reset without shutting down power. (This 

feature is not available on the NCorder application) 

• Get FW Version will retrieve the system’s current firmware version (Nalysis 

communications driver required)  

• Language allows the user to select display in English, Spanish or French. 

(Current set for English only) 

• FW Update auto/man allows the user to select automatic or manual firmware 

update.  This option functions the same as the FW Update radio buttons that 

appear on the top right of the Nalysis screen.  
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5.1.6  Plot Options 
 

 
 

• The Plot Options allow User to set the following options for Plotting 

presentation: 

 

➢ Units 

▪ Allow User to change units to either Metric/Imperial 
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➢ Mile Post 

▪ Allow User to set Distance to plotting 

▪ The mile post is displayed in  

 

 
 

 

➢ Wheel Diameter 

▪ Allow User to set the Wheel Diameter for plotting 
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➢ Change plot signals 

▪ Allow User to select the required Signals for plotting.  See 

Processing Log File section for more details. 
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5.1.7  Inspect Data 
• Use this to perform an inspection on the downloaded log for further 

investigation, click on Inspect Data to navigate through the various options 

 

 
 

 

• See Processing Log File section for more details  

 

 

5.1.8  View 
• Feature to zoom in and out of the plotting data.  See Processing Log File for 

more details. 
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5.1.9 Print 

• Print the data in either Graph or Table form.  See Processing Log File section for 

more details. You can pick from the menu or the button located to the upper-

right with the printer icon. 

• Printing the graph uses a lighter background to reduce printer ink. 

 

 
 

 
 

5.1.10 Window 
• This feature allows Users to select the screen options to switch to Terminal 

screen or the Process file screen 

 

 
 

 

 

• When selecting Terminal from the Window pull down menu, the active screen 

will show the Real-Time Signals Update screen. 
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• When selecting Process file, the active screen will show the data screen that will 

allow User to either process the (*.bli) file or open the (*.pro) file from the File 

pull down menu for data viewing.  See Processing Log File section for more 

details. 
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5.1.11 Help 
 

Warning: Installing the latest NAlysis may not be compatible with your 

existing NForce, NCorder, or NCompass systems.  Ensure that your systems 

are up-to-date before using the latest NAlysis by consulting release notes or 

FMI (field maintenance instruction) documents. 

 

• This Help menu option contains information about NAlysis, Check for Software 

Updates, and Manual 

 

 
 

 

• Ensure that you have a network connection to the Internet, then click on 

Check for Updates. The following window will appear. Click on Download 

NAlysis Installation Zip File or Installation Executable link and follow the 

directions to save the file. 
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If you downloaded the Zip file, double-click on the zip file to view the installer 

file inside.  Double-click on the installation executable to install 

 

• To get the latest user manual, select the Manual option. You’ll be greeted with 

the same options as the Check For Updates option. Click on the NALYSIS User 

Manual link to download. 
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5.2 Terminal Tab 
This Tab screen is not supported on the NCorder Application. 

 

5.3 NCorder Tab 
This Tab screen displays the Real Time Signals update of the NCorder application 

 
 

 

5.3.1 Start/Stop 
In the bottom-right corner, The Start button when pressed toggles to Stop and vice versa.  

Use this to get real-time activity that can provide validation of the installation of your 

NCorder.  Note that the real-time activity will automatically stop querying the NCorder 

after 60 minutes. 
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5.3.2 Erase Log 
 

Use the erase log button to clear the RDU and NCorder logs.  If you have an RDU 

connected, you’ll see a dialog with two checkboxes. This is an automated process that will 

enable the OK button when it has completed.   

 

 

 
 

When both checkboxes are checked and the OK button is enabled, you’ll know that the 

erase procedure finished properly. 

 
 

If the dialog informs you of an error, make sure that your RDU and NCorder are 

connected and retry Erase Log.  Three attempts are made to erase the Flash before failure. 
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If the Syncing fails,  

 

 
 

 

5.3.3 Get Log Info 
 

The button Get Log Info will retrieve flash information from the RDU that is useful for 

Engineering.  During a 100% download from the RDU, these addresses coincide with the Log 

Download pop-up window. 
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5.4 Diagnostic Tab 
 

This Tab screen show the memory table and only use for troubleshooting purpose.  The Erase 

Fault, Erase EPL, and Erase Stats buttons are do not apply to the NCorder and will be disabled 

when NCorder is selected as the application.  See Section 8.2 Diagnostic Tab for more details.   
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5.5 Processing Log File 
 

5.5.1 File Processing 
 

This feature allows the .bli file from a previous download to be converted into 3 different outputs. 

The first output is a .pro output file that can be viewed using the NAlysis plot. Two types of .csv 

files will also be processed into the same directory allowing the user to view tabular data in excel. 

The files will have the same name as the .pro file, one of which with FRA appended to the name. 

The FRA output has the 0-distance point at the time of download and increasing as time moves 

towards the first data point. The non-FRA .csv file has the 0-distance point at the first data point 

and increases with time. If the download is large multiple excel files will be output so that the files 

are not too large for excel to properly open. These files are all one continues file, for example, the 

first data point of section2 file is the data point immediately following the last data point of the 

section1 file. 

 

 

1. To process the downloaded bli file, click on Window->Process File 

 

 
 

- The following screen will appear 
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1. Select File->Process (*bli) 

2. An open file dialog similar to the one below will appear 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
3. Locate the *.bli file that you want to process and click Open. 
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4. Now a save file dialog similar to the one below will appear with a new *.pro file 

name created.  

 

 

 
 

The software needs to convert the binary file to a processed file for plotting. 

5. Click on Save will start the file conversion from *.bli to a *.pro file. 

o CSV files are also created in the same folder.  The file with the FRA designation 

contains distance calculations for every record with the last record being the 

start, or zero distance, position. 

o The other CSV file uses distance calculations for legacy users. 

6. Once completed, NAlysis will ask if you wish to plot the file at this time. 

 

 
 

7. Click the Yes button to begin, if you choose No, you can always plot the file later by 

selecting File->Open->Event Recorder Log from the main menu 

 

5.5.2 File Plotting 
 

When plotting the file is selected, the following window appears.  See Plot Options section 

for more information on plotting 
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You can print this header for your records
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Below is a sample plot:  
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To zoom in on an area, hold down on the left mouse button and drag the cursor over the 

area of interest (white area below) and release the mouse button.  Alternatively, click on 

the area of interest until you see an orange vertical line appear which means you have 

clicked on a data point.  Then use the button with the magnifying glass with the “+” to 

zoom in. 

 

 
 

Here’s the zoomed in white area: 
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Figure 1. Note the mini graph at the bottom after zooming in and the scroll bar.  This mini graph provides 

a reference point for the zoomed in area relative to the entire date range.  With your mouse wheel, you 

can scroll forward or backwards through the time line. 

 

 

To zoom out, right-click on the plot area and select “Undo Zoom” from the context menu.  

Alternatively, use the button with magnifying glass with the “-“. 
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To the right of the graph is a synopsis of the recorder’s data 
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There is also the option to add or remove signals (Plot Signals).  Select NCorder Set->Plot 

Signals the following window will appear.  Choose up to 16 different signals.  If you 

select more than 16, only the first 16 will be plotted.  And Speed cannot be removed 

shown below with the checkbox greyed out. 
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5.5.3 Searching 
 

Options to find a specific signal(s) or time are available.  Click the button showing the 

magnifying glass with the question mark. 

 

 
  

  

You will see a Search Criteria window that defaults to search by Time 

   

 

 

 

Search by Time allows you to specify to the second of the day.  After specifying the time, 

click OK.  If it exists, a pop-up appears confirming the Speed, Date, Time, and Distance; 

and the plot will automatically move to that date and time.  Notice above that the widgets 

for the Select Signals option will be disabled when Search By Time is selected. 
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If the time doesn’t find it, there will be a “No time occurrence found.” message. 

 

 
 

 

 

To search by Signals, select the Signals option that will enable the widgets in the Select 

Signals group. 
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1. Select the Signal, specify greater than or less than, and click the “>” button. 

2. Select multiple signals if desired 
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3. Then click OK.  The plot will move to the first occurrence, if it finds the record that 

meets all the search criteria. 
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5.5.4 Mile Post Menu Item 

 

Select a point on the plot to create the mile post.  An orange vertical line shows where the cursor 

is. 
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Now select Plot Options->Mile Post, the following will appear 

 

 

Select the new distance value and direction and click OK. For example, enter 0.0. 

 
 

The distance readings will now be adjusted to the mile post selection, and the plot will be redrawn.  

Notice the distance is now 0.20 at our mile post selection. The Mile post postion will be displayed 

in the Plot control window to the right of the plot. 
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5.5.5 Inspect Data Menu Item 
 

FRA Scan 
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Select Inspect Data->FRA Scan and the following window will be shown.  Results can be printed.  

 

 

  Fuel Estimate 

 

Select a point on the plot.  An orange vertical line shows where the cursor is. 
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Select Inspect Data->Fuel Estimate. 

 

The following window appears: 
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1. Select the range for the fuel calculation 

a. Entire log – the calculation uses the whole log and ignores any cursors. 

b. Usage to cursor – calculates up to where the orange vertical line occurs.  If there is 

no cursor, no calculation occurs. 

c. Usage from cursor – starts calculation from where the orange vertical line occurs.  If 

there is no cursor, the entire log is assumed. 

2. Select the Units. 

3. Enter the Loco Type along with numeric values for each of the throttle positions. 
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4. Click Calculate button. 
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The estimated fuel usage for each throttle position will be displayed on the right.  You can print 

the fuel estimate using the Print button. 

 

 

If you wish to save the table for future calculations you can do this by clicking Save Table button. 
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Click on Load Table to load a previously saved fuel table.  
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Duty Cycle 

Select a point on the plot.  An orange vertical line shows where the cursor is. 
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Select Inspect Data->Duty Cycle. 

 

 

The following window will be displayed: 
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Select the range for the duty cycle calculation and click OK.  The following should now appear 

 

The results may be printed by selecting Print. 
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5.5.6 Print Options 
 

 
Graph 

a. When select the Graph print option, the Print out will show Plot form of 

data. 

Table 

b. When select the Table print option, the Print out will show the Tabular form 

of data. 

 

 

5.5.7 Data Export 
 

Data can be exported from the plot although we do not recommend it since the process may be 

slow and the data has already been nicely outputted as CSV files as part of the conversion of the 

BLI file.  However, if you must:  

 

1. With your mouse, right-click on the plot to see the context menu appear 
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2. Select Export Dialog… And you’ll see the following dialog.  Select your options.  

Note:  It is not recommended to use the Test/Data option as the data is already 

exported for you in the form of CSV files.  See above reference to FRA output.  

Also, the features of this export dialog are from a third-party control and are not 

designed by NRE.  

 

6.0 NCOMPASS Interface 

The Application Selection of the Nalysis software program contains the NCOMPASS application that will 

allow communications between the Laptop/Computer and the NCOMPASS system. To allow 

communications between the NCOMPASS and the portable computer, connect the Serial Communications 

Cable (NRE Part No. 058-0001-000) between the communications port of the NFORCE NCOMPASS board 

and the portable computer. Computers without serial ports will require a USB to serial adaptor (NRE 

Calgary part # 735-0046-000). The NFORCE cover needs to be removed to access the communications port 

on the faceplate of the NCOMPASS board.  The Nalysis software must establish communications before 

any communications operations occur. 
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 If the NCompass button is selected as shown above, then the following screen will appear: 

 
 

 

 

6.1 Menu 
These are the only menu options available in the NCOMPASS application. 

 

6.1.1 File 
Only Disconnect, Firmware Updates, and Exit from the pulldown menu apply. 

 

6.1.2 Help 
See section 4.1.7 

 

6.2 Terminal Tab 
This Terminal screen behaves similar to the Hyper Terminal screen that has all of the NCOMPASS 

Terminal Commands from the Help menu.  Type in “h” from the terminal prompt to see the 

available commands from the system. 
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6.3 NCompass Tab 
 

 
 

 

 

 

 

6.3.1 Setup 
This is the initial communications setting from NCOMPASS to the Web Portal. 
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6.3.2 Operation 
This is the Real Time communication statistics. 

 

 
 

 

RSSI: Signal strength of either the cellular, or satellite (depends on which is being used)  

SIM Detected:        Yes or No, depends on whether a SIM card has been detected or not 

Connection Type: Type of medium being used for server communications (None, WiFi, Cellular, 

Satellite) 

Socket State: If the NCompass is trying to connect via the cellular module, the state of the socket 

will be shown, useful for debugging 
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6.3.3 GPS 
This shows the location of the Locomotive from the Global Position Satellite.  Whe the 

Start button is clicked, it will update the fields seen below. 

 

 

 
 

• All 1’s indicates no GPS module present 

• All 2’s indicates GPS fix is poor 
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6.3.4 CanNet 
This is the CANBUS status from NCOMPASS and NFORCE communications. 

 

 
 

 

6.3.5 RSSI Real Time Plot 
This is the Real Time Plot of the Received Signal Strength Indicator (RSSI).  It is a 

measure of the power level that a RF client device is receiving from an access point. 

 

 
 

 

6.3.6 SNR Plot 
This is the Signal to Noise Ratio plot.  It is defined as the ratio of signal power to the 

noise power, often expressed in decibels. 
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6.3.7 Terminal screen 
This screen contain the same information as the Terminal Tab screen. 

 

6.3.8 Start Button 
Click the start button that will start real time data acquisition with the NCompass. There 

are four group boxes which will be updated periodically 

 

 
 

   NFID: Current NCompass NFID (NFORCE ID) designation 

   APN: Current APN (Access Point Network) setting 

   Auto APN Select whether APN is tried automatically, or manually 

   Server communication medium to use, in this example Cellular only (indicated by check box) 
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The user can change the NFID (enter new number), select an APN from the drop-down list, then 

select auto or manual APN cycling, and add/remove server medium.  Once new values are 

selected, click on Send. 

 

   If the NCompass accepts the new parameters, the following message will appear: 
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6.3.9 Diagnostic Button 
Clicking on Diagnostic button will output diagnostic messages to the Terminal screen and 

to the list box at the bottom of the NCompass tab.  Messages relating to the connection 

can be helpful.  Switching to the NCompass tab will automatically turn off the 

Diagnostics. 

 

 

6.4 Diagnostic Tab 
This Diagnostic screen is similar to the FS5 memory screen from Hyper Terminal.  This screen 

holds features that can be used for analyzing or troubleshooting the memory tables.  See section 

8.2 for more details. 

 

6.5 Web Portal 
When NCompass is installed on your system, you can take advantage of the NRE’s website portal 

for tracking your fleet.  Through the portal, you can locate your assets, gauge their performance, 

and note how they are being used.  See our Website for more general information: http://nre-

electronics.com/index.php?option=com_content&view=category&layout=blog&id=44&Itemid=67

Information can also be found in the NCOMPASS System Installation Guide (A-580-J-0056-3.doc 

or PDF). 

 

 
 

7.0 WinGov Interface 

Access the WinGov application via the start bar. 
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You’ll have access to four tabs when the application loads: Terminal, WinGov Real Time, WinGov Eng 

Config, and Diagnostic tabs, of which the latter is not necessary for most routine tasks. 

 
 

7.1 Menu 
 

7.1.1 File 
• Disconnect – closes communication port 

• Firmware Update – allows selection of new ECM file to load and update 

• Open – allows selection of recorded real-time data to be loaded.  Make sure that 

you switch to the WinGov Real Time tab (see below) to view the recorded data. 

• Process – changes a binary file (that was downloaded from the Governor) to be 

converted to a CSV (comma separated values) file 

• Exit – close the application 

 

7.1.2 Download Log 
• All – downloads 100% of the Governor log 

• Range – Prompts user for a date range that will be faster in most cases than a 

100% download.  If you want to get the last records recorded choose “End Date” 

from the “To” drop down. 
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7.1.3 Set 
• Real time clock – set the date-time of the Governor’s clock 

 

7.1.4 Options 
• Auto Close RT Window – enables the automatic closing of the RT screen 

• FW Update Auto/Manual 

o Auto – automatic loading and updating of firmware after the file is 

selected 

o Manual – prompts user for directions. 

7.1.5 Help 
About – Version information about NAlysis 

Check for Update – Takes user to NRE Calgary’s website for latest NAlysis software 

Manual – Takes user to NRE’s Calgary website for latest NAlysis manual 

 

 

7.2 Terminal Tab 
Type ‘H’ into the black area of the screen to get further available options 
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7.3 WinGov Real Time Tab 
Monitor real-time data by clicking the “Start” button which will toggle the text to “Stop”.  Press 

“Stop” to end real-time queries to the Governor.  Note that exiting this tab to enter the Terminal tab 

will automatically stop the real-time queries. 
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7.4 WinGov Eng Config Tab 

Load, edit, save, and set the Governor’s configuration. 

 

 
 

 

7.5 Diagnostic Tab 
Does not apply to Governor. 
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8.0 Terminal Interface 

The Terminal Interface is available for NFORCE/NLIMIT systems.  These are systems that do not contain 

the NAlysis communications drivers.  The NAlysis software program only contains the program selections 

that allow communications between the Laptop/Computer and the NFORCE/NLIMIT system through 

Hyper Terminal.  

 

 

 

8.1 Menu 
The Menu options in this Terminal Interface are similar to the NFORCE Interface but are limited 

to some setting due to the absence of Nalysis communications drivers. 

 

8.1.1 File 
This menu is available to User.  See Section 4.1.1 for details. 

 

8. YModem 

For some embedded applications like Equipment Blower Panel (EBP) and Rad Fan Panel 

(RFP), the Firmware Update uses a Binary option instead of the CPU (.ecm) or ST (*.st4).  

In this situation, use the Binary option which uses the YModem protocol. 

 

 
 

When you have selected the file, the download will begin and will appear similar to this 

screenshot. 
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8.1.2 Download Log 
This menu is available to User.  See Section 4.1.2 for details. 

 

8.1.3 Capture 
This menu is available to User.  See Section 4.1.4 for details. 

 

8.1.4 Set 
This menu is available to User.  See Section 4.1.3 for details. 

 

8.1.5 Options 
This menu is available to User.  See Section 4.1.5 for details. 

 

8.1.6 Window 
This menu is available to User.  See Section 4.1.6 for details. 

8.1.7 Help 
This menu is available to User.  See Section 4.1.7 for details. 

 

8.2 Terminal Tab 
This Terminal screen behaves similar to the Hyper Terminal screen that has all of the NForce 

Terminal Commands from the Help menu.  Type in “h” from the terminal prompt to see the 
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available commands from the system.  See Terminal Interface Guide A-820-J-001-X (X = latest 

revision) for more details on Hyper Terminal communications. 

 

 

 
 

In addition, there are optional radio buttons on the right-hand side of the Terminal screen that can 

be used as follows: 

 

8.2.1 Help Button 
➢ Click on the Help button will bring up the Help menu from the Terminal prompt 

screen. 

 

8.2.2 Exit 
➢ Click on the Exit button will exit any active screen and return to the terminal 

prompt screen. 

 

8.2.3 Clear Screen 
➢ Click on Clear Screen will clear all the messages from the Terminal prompt 

screen. 

 

8.2.4 Close RT 
➢ Click on Close RT will close the Real-Time updates from system and return to 

the Terminal prompt screen. 

 

Note: The Terminal prompt screen always has a BLACK background.  Any other screen will have 

a WHITE background (Active screen). 
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9.0 Generic Screen Tabs 

9.1 Terminal Tab 
 

This Terminal screen is similar to the Hyper Terminal screen.  Type in “H” from the terminal 

prompt to view the list of Terminal Commands.  This list of commands varies from one application 

to another as shown in the following example. 

 

 
 

Note: This Tab screen only available for the NFORCE/NLIMIT applications that is supported by 

Hyper Terminal. 

 

9.2 Diagnostic Tab 
 

This Diagnostic screen is similar to the FS5 memory screen from Hyper Terminal.  This screen has 

the following features that can be used for analyzing or troubleshooting the memory tables. 
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9.2.1 Erase Fault 

Click on the Erase Fault button and select “Yes” will erase the Fault Log from the system 

 
 

9.2.2 Erase EPL 
Click on the Erase EPL button and select “Yes” will erase the Extended Log from the 

system 

 
 

9.2.3 Erase Stats 
Click on the Erase Stats button and select “Yes” will erase the Statistics Log from the 

system 
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9.2.4 Flash Info 
Click on the Flash Info button will display the Flash information of the system 

 

 
 

9.2.5 Repair Cal 
Click on the Repair Cal button will repair the calibration table if necessary. Otherwise the 

following pop up window will show 
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9.2.6 Previous 
This selection is used for trouble shooting purpose only. 

 

9.2.7 Next 
This selection is used for trouble shooting purpose only. 

 

9.2.8 Read Flash 
This selection is used for trouble shooting purpose only. 

 

9.2.9 Read RAM 
This selection is used for trouble shooting purpose only. 
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10.0 Abbreviations used in NFORCE Download Files 

 

TIME Time in hours, minutes, seconds and 1/10th seconds for each record. 

DATE Date in day/month/year (fault and extended logs) 

2t Alarm trainline input (attendant call.) 

3t DV throttle trainline input. 

5t Emergency Sand trainline input. 

6t Generator field trainline input. 

7t CV throttle trainline input. 

8t Forward direction trainline input. 

9t Reverser direction trainline input. 

10t Wheel slip trainline input. 

10msT  gate pulse off for WS TMI 6 or WS ATMV6 

12t BV throttle trainline input. 

13t Control and fuel pump trainline input. 

15t AV throttle trainline input. 

16t Engine run trainline input. 

17t Dynamic Brake setup trainline input. 

20t Dynamic Brake warning trainline input. 

21t Dynamic Brake excite trainline input. 

22t Air Compressor Control trainline input. 

23t Manual Sand trainline input. 

24t Dynamic Brake reference voltage trainline input. 

24vcb  24V control circuit breaker digital input. 

26t Ground Relay Reset trainline input. 

AATS or AIR Ambient Air temperature sensor (°C). 

ABDR Compressor 2 Air Dryer Magnet Valve digital output. 

ABR Alarm Bell coil drive digital output. 

AC1P Auxiliary Power GS1 relay digital output.  

AC2P  Auxiliary Power GS2 relay digital output. 

AC3P  Auxiliary Power GS3 relay digital output. 

ACC  speed acceleration 

acc1  Auxiliary Power GS1 contactor feedback digital input. 
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acc2  Auxiliary Power GS2 contactor feedback digital input. 

acc3  Auxiliary Power GS3 contactor feedback digital input. 

ACCEL 
 speed acceleration multiplied by 161 then divided by 10000. 
Conversion to KPH acceleration. 

ACCEL or ACC Wheel acceleration (mph/s x 10). 

ACINV  A/C Inverter enable digital output. 

acmp1  Air Compressor 1 Over Temperature digital input. 

acmp2 Air Compressor 2 Over Temperature digital input. 

acomp  Air Compressor Over Temperature digital input. 

acrst  A/C Reset Switch digital input. 

ACT1, ACT2, ACT3, ACT4, 
ACT5, ACT6 

Traction motor armature currents (Adc), 0 - 2000 A. 

ACV Auxiliary AC Bus voltage (Vac). 

AHP  Auxiliary Power (hp). 

aux Auxiliary generator digital input. 

AUXFL  Auxiliary Power Fault digital output. 

AV, BV, CV, DV Governor valve solenoid digital outputs. 

b B contactor feedback digital input. 

B B contactor coil digital output. 

BATCT 64V battery charging current sensor, 0-200A 

BC Brake cylinder pressure sensor (PSI), 0 - 200 PSI. 

BCT1, BCT2, BCT3 Grid resistor current sensors (Adc),  0 – 1000 A. 

BDR Compressor 1 Air Dryer Magnet Valve digital output. 

Bf(a) Battery field contactor feedback digital input. 

BF(A) Battery field contactor coil digital output. 

BFCT Battery field current sensor, 0-100A 

BMT, BMT1,  BMT2 Dynamic brake grid blower current sensor (Adc), 0 - 200 A. 

br Braking relay feedback digital input.  

BR Braking relay coil digital output. 

BUZZ NLIMIT warning buzzer digital output. 

BWR Brake warning relay digital output. 

bwr  Brake warning relay feedback digital input. 

c1flt Chopper 1 Fault digital input. 

C1JT  Chopper 1 Junction model temperature (°C). 

c2flt  Chopper 2 Fault digital input. 

C2JT  Chopper 2 Junction model temperature (°C). 
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c3flt  Chopper 3 Fault digital input. 

C3JT  Chopper 3 Junction model temperature (°C). 

c4flt  Chopper 4 Fault digital input. 

C4JT  Chopper 4 Junction model temperature (°C). 

c5flt  Chopper 5 Fault digital input. 

C5JT  Chopper 5 Junction model temperature (°C). 

c6flt  Chopper 6 Fault digital input. 

C6JT  Chopper 6 Junction model temperature (°C). 

CABHT  Cabin Heater currents (Adc), 0 - 66A. 

cc1  CC1 contactor feedback digital input. 

CC1  CC1 contactor coil digital output. 

cc2  CC2 contactor feedback digital input. 

CC2  CC2 contactor coil digital output. 

cc3  CC3 contactor feedback digital input. 

CC3  CC3 contactor coil digital output. 

cer  Chopper enable relay digital input. 

chcb  Chopper circuit breaker digital input. 

CHT1  Chopper 1 base plate temperature (°C). 

CHT2  Chopper 2 base plate temperature (°C). 

CHT3  Chopper 3 base plate temperature (°C). 

CHT4  Chopper 4 base plate temperature (°C). 

CHT5  Chopper 5 base plate temperature (°C). 

CHT6  Chopper 6 base plate temperature (°C). 

crl Compressor relay feedback digital input. 

CRL  Compressor relay coil digital output. 

CTA  Air compressor current (Aac), 0 - 200 A. 

CTB  Equipment blower current (Aac), 0 - 200 A . 

CTC  LVPS current (Aac), 0 - 200A 

CTD  72 V battery charging current (Adc), 0 - 200 A. 

CTE  24 V battery charging current (Adc), 0 - 200 A. 

CTF  DC bus current (Adc), 0 - 2000 A. 

CTG Fireman’s Heater current (Adc), 0 - 66A. 

CTH Cabin heater currents (Adc), 0 - 66A. 

D14V D14 companion alternator voltage (Vac). 

dACT  delta all traction motor currents 
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dact1-6  delta ACT currents 

dadt  Wheel acceleration rate of change control signal. 

DB%  Dynamic brake handle percentage control signal. 

DBBL  Dynamic brake grid blower current (Adc), 0 - 200 A. 

dbco  Dynamic brake cutout digital input. 

DBTMV12 Traction motor 1&2 differential voltage in DB (Vdc), 0 - 1739 V. 

DBTMV14 Traction motor 1&4 differential voltage in DB (Vdc), 0 - 1739 V. 

DBTMV25 Traction motor 2&5 differential voltage in DB (Vdc), 0 - 1739 V. 

DBTMV34 Traction motor 3&4 differential voltage in DB (Vdc), 0 - 1739 V. 

DBTMV36 Traction motor 3&6 differential voltage in DB (Vdc), 0 - 1739 V. 

dc1, dc2, dc3, dc4 Grid shorting contactor feedback digital input. 

DC1, DC2, DC3, DC4 Grid shorting contactor coil digital output. 

DCI  DC bus current (Adc), 0 - 2000 A. 

DCV  DC bus voltage (Vdc), 0 - 1739 V. 

dD14V Companion alternator output voltage rate of change, volts AC / s. 

dMGV Change (delta) in generator voltage. 

dTMI Change (delta) in average traction motor current. 

dtmi1-6   filtering of ACT input signals 

dtmv1  Change (delta) TMV input 

DUTY1  DC chopper 1 duty cycle output (% x 100). 

DUTY2  DC chopper 2 duty cycle output (% x 100). 

DUTY3  DC chopper 3 duty cycle output (% x 100). 

DUTY4  DC chopper 4 duty cycle output (% x 100). 

DUTY5  DC chopper 5 duty cycle output (% x 100). 

DUTY6  DC chopper 6 duty cycle output (% x 100). 

ebc  Equipment blower contactor feedback digital input. 

EBC  Equipment blower contactor coil digital output. 

ECMP  Engine computer main power relay digital output. 

efcut  effective cut (RC cut) 

efs Engine filter switch digital input. 

EOPT Engine Oil Pressure Transducer (psi), 0 – 200 psi. 

EOTS Engine Oil Temperature Sensor (°C). 

EPDO Engine Protection Defeat digital output. 

EXC LMT 
Excitation limit message. This field is loaded by any control module 
that is limiting or reducing rate charging for a specific reason. Please 
see the operating manual for a complete list of possible excitation 



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 117 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

reduction messages possible. 

EXCL, EXCU and EXC3 (or 
EXC1-16, EXC17-32 or EXC33-
48) 

 excitation limit message can only display most recent message, 
although more than one can be active at a time.  We can decode 
these hex numbers to analyze for multiple active limits 

fbmcb  Filter blower circuit breaker digital input. 

fc1, fc2, fc3 Fan contactor feedback digital input. 

FC1, FC2, FC3 Fan contactor coil driver digital output. 

fcfa  Equipment blower high speed FCFA contactor feedback digital input. 

fcfb Equipment blower high speed FCFB contactor feedback digital input. 

FCFR  Equipment blower high speed contactor coils digital output. 

fcs Equipment blower low speed contactor feedback digital input. 

FCSR  Equipment blower low speed contactor coil digital output. 

FLT1-5 
 Active faults, used to see when faults are set.  You will see full 
messages for these in the fault and EPL logs. 

fpc Fuel pump control digital input. 

fpcr  Fuel pump control relay digital input. 

Fs, fs1a, fs1b, fs2a, fs2b Field shunt contactor feedback digital input. 

FS, FS1A, FS1B, FS2A, FS2B Field shunt contactor coil digital output. 

FTRt  forward transition recovery time 

FTSF  forward sand magvalve control 

FUEL NGAUGE Fuel Level. 

fvs Filter Vacuum Switch digital input. 

FW_R  firmware revision number 

FW_V  firmware version number 

FWVER Firmware version installed at that instance of the record 

g1brk  GS1 main circuit breaker digital input. 

G1EE  GS1 engine enable digital output. 

g1fan  GS1 fan control relay digital input. 

g1fcb  GS1 filter fan breaker digital input. 

G1FLT  GS1 fault digital output. 

G1H20  GS1 water temperature (°F) 

g1oil  GS1 oil level digital input. 

g1ots  GS1 rectifier over temperature digital input. 

G1P1I  GS1 phase 1 current (Aac), 0 - 2000 A. 

G1P3I  GS1 phase 1 current (Aac), 0 - 2000 A. 

G1PSI  GS1 oil pressure (PSI). 
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G1RPM  GS1 rpm. 

G1SRV  GS1 service engine digital output. 

G1STA  GS1 engine start digital output. 

G1VRO  GS1 voltage regulator on digital output. 

g2brk  GS2 main circuit breaker digital input. 

G2EE  GS2 engine enable digital output. 

g2fan  GS2 fan control relay digital input. 

g2fcb  GS2 filter fan breaker digital input. 

G2FLT  GS2 fault digital output. 

G2H20  GS2 water temperature (°F) 

g2oil  GS2 oil level digital input. 

g2ots  GS2 rectifier over temperature digital input. 

G2P1I  GS2 phase 1 current (Aac), 0 - 2000 A. 

G2P3I  GS2 phase 1 current (Aac), 0 - 2000 A. 

G2PSI  GS2 oil pressure (PSI). 

G2RPM  GS2 rpm. 

G2SRV  GS2 service engine digital output. 

G2STA  GS2 engine start digital output. 

G2VRO  GS2 voltage regulator on digital output.  

g3brk  GS3 main circuit breaker digital input. 

G3EE  GS3 engine enable digital output. 

g3fan  GS3 fan control relay digital input. 

g3fcb  GS3 filter fan breaker digital input. 

G3FLT  GS3 fault digital output. 

G3H20  GS3 water temperature (°F) 

g3oil  GS3 oil level digital input. 

g3ots  GS3 rectifier over temperature digital input. 

G3P1I  GS3 phase 1 current (Aac), 0 - 2000 A. 

G3P3I  GS3 phase 1 current (Aac), 0 - 2000 A. 

G3PSI  GS3 oil pressure (PSI). 

G3RPM  GS3 rpm. 

G3SRV  GS3 service engine digital output. 

G3STA  GS3 engine start digital output. 

G3VRO  GS3 voltage regulator on digital output.  

GATE SCR Gate fire analog output, (0 - 4095). 
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gfa Generator field contactor feedback digital input. 

GFA Generator field contactor coil digital output. 

gfc Generator field contactor feedback digital input. 

GFC Generator field contactor coil digital output. 

GFCT Generator field current sensor (Adc), 0 - 200A. 

gfd Generator field decay contactor feedback digital input. 

GFD Generator field decay contactor coil digital output. 

gr Ground relay digital input. 

GRCNT  Ground relay events count while motoring. 

grco Ground relay cutout switch digital input. 

GRID1, GRID2, GRID3 Grid 1 current sensor (Adc), 0 - 1000 A. 

GRN NLIMIT Green indicator led digital output. 

grrst Ground relay reset switch digital input. 

GRRST Automatic ground relay reset coil digital output. 

grrst  ground relay reset switch 

GVSR Governor Servo relay coil digital output. 

hbap  Hand brake applied digital input. 

hbrl  Hand brake released digital input. 

hdrst Headlight reset switch digital input. 

her Hot Engine relay feedback digital input. 

HER Hot Engine relay coil digital output. 

hlrst headlight reset switch 

HOLD 1 and 2 hold gate 

HPLAT traction power prior to gate hold 

IDEAL  Ideal brake power (hp). 

Idiff differential between minimum and maximum ACT readings 

Idle limit 
state of idle limit control, standby, restart, pre S/D, shutdown,  
disabled 

iout1 4-20mA control output, may be used to drive NFIELD BFD 

ips Independent pressure switch digital input. 

is Isolation switch status digital input. 

J ACT  J1939 engine communication activity. 

J OK  J1939 engine communication OK. 

ldsnd or ldsd Lead truck sand switch digital input. 

los Governor low oil switch digital input  



DWG #A-820-J-530-5          NALYSIS USER MANUAL 13JAN2021 

Page 120 
 

Copyright © 2021 NRE Calgary All Rights Reserved                           

The contents of this document are proprietary or confidential to NRE Calgary or its suppliers, and shall not be further disclosed, disseminated, 
copied, duplicated, or used except for purposes authorized by contract or otherwise expressly authorized in writing. 
 

 

 

 

 

LR Engine load regulator % of maximum field, 0-100%. 

LRW Engine load regulator wiper voltage (Vdc), 0-80 V. 

lsc Load shed contactor coil digital output. 

LSC Load shed contactor feedback digital input. 

lssw  Yard mode selector switch digital input. 

lt1, lt2, ltt1, ltt2 Load test transfer contactor feedback digital input. 

LTR Load test transfer pilot relay coil digital output.  

ltsw or lttsw Load Test selector switch digital input. 

LTT1, LTT2 Load test transfer contactor coil digital output. 

lvflt LVPS fault digital input. 

LVPS LVPS power (hp). 

m1  M1 contactor feedback digital input. 

M1  M1 contactor coil digital output. 

m2, m3, m4, m5, m6 M contactor feedback digital inputs.  

maxD and MaxD1 Maximum differential traction motor current in WS recovery 

mb-b Braking position switchgear feedback digital input. 

mb-m Motoring position switchgear feedback digital input. 

mco1, … , mco6 Traction motor cutout solenoid feedback digital inputs. 

MCO1, …, MCO6 Traction motor cutout solenoid drive digital outputs. 

mco16, mco25, mco34,  Traction motor cutout solenoid feedback digital inputs. 

mco43, mco52, mco61 Traction motor cutout solenoid feedback digital inputs. 

MCOR Traction motor cutout relay coil digital output. 

mcos1, …, mcos6 Traction motor cutout request switch digital inputs.  

mcosw Motor cutout switch 

mcs16, mcs25, mcs34 Traction motor cutout switch digital inputs. 

MFR  Motor fail relay coil digital output. 

MGA Main generator output current (Adc), 0 – 4800 A.  

MGCT Main generator output current sensor (Adc), 0 – 2000 A. 

MGV Main generator output voltage (Vdc), 0 – 1250 V. 

minD, minD1 
Minimum differential traction motor current in WS recovery, D1 is at 
10ms 

mmd1-6 Minimum/maximum differential traction motor current 

MR  Main air reservoir pressure (PSI), 0 - 200 PSI.   

MR2PT Secondary air reservoir pressure (psi), 0 – 200 psi. 

MRPT  Main air reservoir pressure (psi), 0 - 200 psi.   
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msand Manual sand trainline digital input. 

mtr  Motor relay feedback digital input. 

MTR  Motor relay coil digital output. 

MTRA  Motor 1-3 relay coil digital output. 

MV1SF Forward truck lead axle sanding magnet valve digital output. 

MV1SR Forward truck rear axle sanding magnet valve digital output. 

MV2SF Rear truck lead axle sanding magnet valve digital output. 

MV2SR Rear truck leading axle sanding magnet valve digital output. 

MVBD  Compressor blow down magnet valve drive digital output. 

MVCC  Compressor control magnet valve drive digital output. 

MVFC Fan clutch magnet valve drive digital output. 

MVSH Fan shutter magnet valve drive digital output. 

NHC  Heater contactor drive digital output. 

nsr  No speed relay feedback digital input. 

NSR  No speed relay coil digital output. 

ovrd Idle limit override switch 

p1, …, p6 P contactor feedback digital inputs. 

P1, …, P6 P contactor coil digital outputs. 

p12, p25, p34 P contactor feedback digital inputs. 

P25, P34  P contactor coil digital outputs. 

pa Local control breaker digital input. 

Parallel P contactor feedback digital input. 

pcr Pneumatic control relay digital input. 

pcs Pneumatic control switch digital input. 

PID Excitation magnitude of change control signal. 

plst2  pulse gate off timer 

PRIME or PMR Engine Prime drive digital output. 

prog Chopper programming digital input. 

rate Loading rate at instance of record (% x 10). 

RC Rate Control excitation control signal, 0-100%. 

rcl  Remote system active digital input. 

RED NLIMIT Red indicator led digital output. 

RPM Engine rpm. 

RTSR Reverse sand magvalve control 

run Isolation switch status digital input. 
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rv1, … , rv6  Forward reverser contactor feedback digital inputs. 

rvf Reverser pilot relay feedback digital input. 

RVF Reverser pilot relay coil digital output. 

rv-f  Forward reverser switchgear interlock digital inputs. 

rvf16, rvf25, rvf34 Forward position reverser switchgear interlock digital inputs. 

rvr Reverser pilot relay feedback digital input. 

RVR Reverser pilot relay coil digital output. 

rv-r Reverse reverser switchgear interlock digital input. 

rvr43, rvr52, rvr61 Reverse position reverser switchgear interlock digital inputs 

s13,s14,s16,s24,s25,s34,s36  Series-parallel contactor feedback digital input. 

S13,S14,S16,S24,S25,S34,S 
36  

Series-parallel contactor drive digital output. 

SAND Sanding relay digital output. 

sb Series bridge contactor feedback digital input. 

SB Series bridge contactor drive digital output. 

sdovr Shutdown override switch digital input. 

sf Generator shunt field contactor feedback digital input. 

SF Generator shunt field contactor coil digital output. 

shpc  Shore power contactor digital input. 

shpr  Shore power pilot relay digital input. 

SLOWR 
Code to show reason NFORCE is applying a slow control rate (PID to 
100) 

spc  Spotter contactor feedback digital input. 

spot  Spotter switch digital input. 

SPR  Spotter contactor coil digital output. 

sprD, sprD1 
Maximum differential TMI minus minimum differential TMI (spread 
differential), and spread differential at 10 ms 

SPx10 
Locomotive ground speed as detected by the axle generator (mph x 
10). 

SSR Slow Speed relay coil digital output. 

START Engine start digital output. 

start  Engine start switch digital input. 

STOPC Code to show reason NFORCE is applying stop charge (PID to zero) 

TCO 1 Truck 1 cutout indicator light digital output. 

TCO 2 Truck 2 cutout indicator light digital output. 

THOLD Gate hold due to TMV slip correction 
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THP  Traction power (hp). 

THROTTLE Control stand throttle position. 

tlpr Turbo lube pump relay digital input 

TLPR Turbo lube pump relay drive digital output 

TMI Average traction motor armature current 

TMI1, …, TMI6  Traction motor armature currents (Adc), 0 - 2000 A. 

tmigp Gate pulse timer for WS TMI 1-4 

TMT1, …, TMT6 Traction motor modeled temperatures (°C). 

TMV1 Traction motor 1 voltage (Vdc), 0 - 1739 V. 

TMV1, …, TMV6 Traction motor voltages (Vdc), 0 - 1739 V. 

TMV12 Traction motor 1&2 differential voltage (Vdc), 0 - 1739 V. 

TMV14 Traction motor 1&4 differential voltage (Vdc), 0 - 1739 V. 

TMV2 Traction motor 2 voltage (Vdc), 0 - 1739 V. 

TMV25 Traction motor 2&5 differential voltage (Vdc), 0 - 1739 V. 

TMV34 Traction motor 3&4 differential voltage (Vdc), 0 - 1739 V. 

TMV36 Traction motor 3&6 differential voltage (Vdc), 0 - 1739 V. 

TMVAV Average traction motor armature voltage (Vdc), 0 - 1739 V. 

TR Transition relay coil digital output. 

trks1 Truck 1 cutout request switch digital inputs.  

trks2 Truck 2 cutout request switch digital inputs.  

VRC Voltage regulator change relay coil digital output. 

WATER Engine radiator coolant temperature (°F). 

WLR Wheel slip light relay coil digital output. 

YEL NLIMIT Yellow indicator led digital output. 
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11.0 Speed Indicator Setting: 

➢ Ensure the locomotive is stopped. 

➢ NALYSIS must establish communications with the Speed Indicator before any communication 

operation can be completed. This is done by connecting the communications (or download) cable 

(NRE P/N: 058-0001-000) from the Speed Indicator’s communication port (Lemo connector on the 

back of the speed indicator) to a portable computer (or Laptop). 

➢ Launch NCORDER NALYSIS and select “Speed Indicator” from the Set pulldown menu. 

 

Select Set->Speed Indicator 
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For Imperial Units, the following panel will be displayed 

 

 

• Locomotive Overspeed can be set between 20 and 100 MPH (32-160 KPH) 

• Wheel Diameter can be set between 32.0” and 47.0” (813 mm and 1192 mm) 

 

For Metric Units, the following panel will be displayed 

 

 

• Locomotive Overspeed can be set between 20 and 100 MPH (32-160 KPH) 
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• Wheel Diameter can be set between 32.0” and 47.0” (813 mm and 1192 mm) 

12.0 Customer Support 

For general questions regarding the Analysis/Download Software program, contact NRE Calgary 

technical support personnel. 

Before contacting NRE Calgary with questions about this product or any of its ancillary 

equipment, carefully review the contents of this guide. If you are unable to find an explanation for 

problems with your equipment, gather the following information prior to contacting NRE Calgary: 

• The System Type (NFORCE, NCORDER, NCOMPASS, WinGov, or NLIMIT) and 

Part Number that is experiencing problems 

• The version number of the System Internal Operating Firmware 

• The serial number of the System 

• The type of locomotive with the installed System 

• The version number of the Nalysis software program 

• The type of Laptop/Computer being used 

• A detailed description of the problem(s) 

NRE Calgary Co. 

4905 – 77 Avenue S.E. 

Calgary, Alberta  T2C 2X4 

Phone: 403-279-4447 

Fax: 403-279-4463 

Support Phone: 587-893-5348 

Email: supportelectronics@nre.com  

NRE Calgary website: www.nre-electronics.com 

NRE Corporate website: www.nre.com  
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